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Preface

This document describes how to use the Data Mapping Tool to generate a global format buffer
(GFB) and field table (GFFT) for use with the Event Replicator and the Event Replicator Target
Adapter.

Note: You can also use the Event Replicator Administration with Predict to generate GFBs
and the associated field table. For more information, read Maintaining GFB Definitions, in
the Event Replicator Administration User's Guide.

This document covers the following topics:

Describes changes made to the Data Mapping Tool in this release.Data Mapping Tool Release Notes

Provides an overview of the Data Mapping Tool.Overview

Describes system requirements to use the Data Mapping Tool.Platform Coverage and Prerequisites

Describes how to install the Data Mapping Tool.Installing the Data Mapping Tool

Describes the Data Mapping Tool interface as well as how to
start and shut down the Data Mapping Tool.

Data Mapping Tool User Interface and
Mechanics

Describes how to set the default number of occurrences for MU
and PE fields.

Setting theDefaultNumber ofOccurrences
for MU and PE Fields

Explains how to select a source Natural Data Definition Model
(DDM) to use with the Data Mapping Tool.

Locating and Selecting a Source DDM

Describes how to request that MU and PE fields be flattened
during replication.

Flattening Fields for Replication

Describes how to select and remove target relational database
tables from the Data Mapping Tool.

Maintaining the Target Relational
Database List

Describes how to create a GFB schema, review the GFB schema
layout, and remove the schema and user tables from the Data
Mapping Tool.

Creating and Maintaining the GFB
Schema

Describes how to generate an Event Replicator for Adabas global
format buffer (GFB) and corresponding field table from a GFB
schema in the Data Mapping Tool.

Generating the GFB and Field Table

Describes the log files produced by the Data Mapping Tool and
their location.

Managing Logging and Log Files

v
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1 Data Mapping Tool Release Notes

This release of the Data Mapping Tool has been rewritten in Java and Eclipse. In addition, the
following enhancements and changes have been introduced:

■ Data is now stored in local XML files.
■ RDBMS tables are no longer created during the DDM drag-and-drop operation. GFB schemas

can be changed, columns renamed or deleted; even whole MU/PE subtables can be removed
from the field table (GFFT). The RDBMS tables are only created by the Event Replicator Target
Adapter during the actual data replication.

■ The GFB schema name you specify when you create the schema will now be used for the resulting
RDBMS table name. Once you have created a GFB schema for a relational database from a DDM,
you can rename it and the fields within the schema. These updates will be reflected in the table
and columns names of the RDBMS table.

For more information about renaming schemas and schema fields, readRenaming Schemas and
Renaming Schema Fields, elsewhere in this guide.

■ You can now drag and drop single fields from a DDM onto existing RDBMS columns to create
or modify a GFB schema that maps data to existing RDBMS tables.

For more information about dragging and dropping individual fields, readCreating the Schema
from Individual Fields in the DDM, elsewhere in this guide.

■ Once you have created a GFB schema for a relational database from a DDM, you can redefine
(split) fields within the schema. This allows the data in the field to be redefined over more than
one column in the resulting RDBMS table.

Note: Attempts to redefine schem fields require that Event Replicator for Adabas 3.2.1
be installed and in use at your site.

For more information about redefining fields in a GFB schema, read Redefining Schema Fields,
elsewhere in this guide.
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■ Once you have created a GFB schema for a relational database from a DDM, you can change
the primary key for a table. In addition, you can create a composite key from one or more fields
in the schema.

Note: Attempts to create composite keys require that Event Replicator for Adabas 3.2.1
be installed and in use at your site.

For more information about creating composite keys in a GFB schema, read Specifying Keys,
elsewhere in this guide.

■ When creating the GFB schema, the values for theRDBMS Format field have changed to match
those generated for the Event Replicator Target Adapter. For example, the value "A - Alphanu-
meric" now appears as "S - String".

■ When generating the GFB and field table, the statistics shown for (MU) fields have changed.
The statistics now show the ending occurrence number instead of the number of occurrences.

Note: Support for 32-bit Linux operating systems will be dropped in a future version.

Using the Data Mapping Tool2
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2 Overview

The Data Mapping Tool is a graphical user interface that allows you to generate a global format
buffer (GFB) and field table (GFFT). Using the interface you can drag and drop a Natural data
definition module (DDM) onto a target RDBMS, adjust the resulting GFB schema, and generate the
GFB and GFFT. In addition, you can drag and drop individual fields from a DDM onto existing
RDBMS columns to create or modify a GFB schema that maps data to existing RDBMS tables.

Natural DDMs provide a logical definition of a physical database and can be generated using
Natural's SYSDDM utility or from Predict. DDMs allow convenient and transparent access of the
Adabas data to different database management systems. For each physical file in a database, one
or more DDMs can be defined. For complete information on generating a Natural DDM, refer to
your Natural or Predict documentation.

Note: You can also use the Event Replicator Administration with Predict to generate GFBs
and the associated GFFT. For more information, read Maintaining GFB Definitions, in the
Event Replicator Administration User's Guide.
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3 Platform Coverage and Prerequisites

■ Supported Operating Systems ............................................................................................................. 6
■ Supplied Third-Party Software ............................................................................................................. 6
■ Prerequisites .................................................................................................................................... 6
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Note: We recommend that you read the install.txtfile in the CD root directory for last-minute
information regarding the installation of Adabas Manager and its subcomponents. We also
recommend that you read the Adabas Manager and Data Mapping Tool Readme files for
last-minute information regarding the operation of Adabas Manager and the Data Mapping
Tool. The Data Mapping Tool Readme file can be found in the Program Files\Software
AG\Adabas Manager n.n.n\MappingTool directory on Windows systems and in the
$SAG/ama/vnn/MappingTool directory on UNIX systems after Adabas Manager is installed
(where n.n.n and nn represent the version number of Adabas Manager).

Supported Operating Systems

The complete list of operating systems supported by the Data Mapping Tool is provided in the
Adabas Manager readme.txt file, found in the root directory on the installation CD.

UNIX and LINUX installations require an X-Windows graphical environment to run the Data
Mapping Tool.

Supplied Third-Party Software

JRE 1.6.0_07 is automatically installed with the Data Mapping Tool (this version of Java is required
for this version of the Data Mapping Tool).

Prerequisites

Note: JRE 1.6.0_07, bundled with the Data Mapping Tool, is required for this version of the
Data Mapping Tool. It is also included in the Data Mapping Tool installation kit.

■ A data definition module (DDM) of your Adabas database must be generated from Software
AG's Natural or Predict products. For more information, read your Natural or Predict document-
ation. A sample DDM of the Adabas Employees demo file is included in the Data Mapping Tool
installation.

■ Java Database Connectivity (JDBC) drivers are required to communicate with an RDBMS to
display existing table and column information in the Data Mapping Tool's middle pane. However,
it is possible to use the Data Mapping Tool without communicating with an RDBMS. The fol-
lowing table lists the relational databases supported by the Data Mapping Tool as well as the
required JDBC drivers for each.

Using the Data Mapping Tool6
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Required JDBC DriverRDBMS Support

db2jcc.jar
db2jcc_license_cu.jar

DB2 8.2 Universal Database (open systems), or later

db2jcc.jar
db2jcc_license_cisuz.jar

DB2 Universal Database (UDB) version 8 for z/OS, or
later

msbase.jar
mssqlserver.jar
msutil.jar

Microsoft SQL Server 2000 Service Pack 4

sqljdbc4.jarMicrosoft SQL Server 2005 or 2008

mysql-connector-java-v.r.s-bin.jar , where v.r.s
represents the MySQL release number.

MySQL 5.0.17, or later

classes12.jarOracle Database 10g

ojdbc6.jarOracle Database 11g, or later

jconn2.jarSybase SQL Anywhere 9.0.2, build 3221, or later

jconn3.jarSybase ASE 15.01, or later

tdgssconfig.jar
tdgssjava.jar (required only for versions prior to
version 12)
terajdbc4.jar

Teradata Version 2 Release 6.01, or later

Download the appropriate JDBC driver files from your relational database vendor or obtain
them from an installation package and copy them to the following Data Mapping Tool subdir-
ectory: plugins/JDBC_Libraries_1.1.1.

■ You must have Event Replicator for Adabas 3.2.1 installed to use the redefines and composite
key features of the Data Mapping Tool.

■ UNIX and LINUX installations require an X-Windows graphical environment to run the Data
Mapping Tool.

7Using the Data Mapping Tool
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4 Installing the Data Mapping Tool

The Data Mapping Tool is installed when Adabas Manager and Event Replicator Administration
are installed. For more information about installing Adabas Manager and Event Replicator Admin-
istration, read Installing Adabas Manager.

The default installation directory is a Mapping Tool directory wherever Adabas Manager program
files are installed.

If you have installed the Data Mapping Tool in a Windows Vista environment and intend to
share the Data Mapping Tool and its mapping data with multiple users, you must perform some
configuration steps for the Data Mapping Tool prior to using it. These steps move the shared data
files to the Vista public data area C:\Users\Public and create a modified copy of the Data Mapping
Tool's configuration file to point to them.

The Windows Vista configuration steps you must perform are:

1 Make sure that you are logged on as an administrator on the machine where the Data Mapping
Tool is installed.

2 Copy the following Data Mapping Tool subdirectories to C:\Users\Public\MappingTool:

■ data
■ systrans
■ logs

3 Locate theMT-Config.xmlfile wherever the Adabas Manager, Event Replicator Administration,
and Data Mapping Tool program files are installed.

4 Copy the MT-Config.xml file to a location outside of the C:\Program Files directory. Windows
Vista does not allow files in the C:\Program Files directory structure to be edited.

5 Delete the original MT-Config.xml file from its installed C:\Program Files location, wherever
you found it in Step 2.
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6 Edit the copy of theMT-Config.xmlfile using any text editor. Change the </MappingFilePath>,
</DDMFilePath>, and </LoggingFilePath> entities in the MT-Config.xml file, so that they
direct mapping data files and specifications to the path C:/Users/Public, as shown below.

<?xml version="1.0" encoding="UTF-8" standalone="no" ?>
- <MTConfig>

<MappingFilePath value="C:/Users/Public/MappingTool/data" />
<DDMFilePath value="C:/Users/Public/MappingTool/systrans" />
<DDMFileExtensions value=".systrans;.ddm" />
<LoggingFilePath value="C:/Users/Public/MappingTool/logs" />
<LoggingLevel value="DEBUG" />
<DefaultOccurrences value="5" />
</MTConfig>

7 Save the edits you have made and copy the file back to its original installed location in
C:\Program Files, wherever you found it in Step 2.

Multiple users should now be able to use the Data Mapping Tool and share its mapped data.

Using the Data Mapping Tool10
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5 Data Mapping Tool User Interface and Mechanics

■ Starting the Data Mapping Tool .......................................................................................................... 12
■ Shutting Down the Data Mapping Tool ................................................................................................. 14
■ The Data Mapping Tool Interface ........................................................................................................ 14

11



This chapter describes how to start and shut down the Data Mapping Tool and provides an over-
view of the Data Mapping Tool interface.

Starting the Data Mapping Tool

To start the Data Mapping Tool in Windows environments, complete the following steps:

■ Select Data Mapping Tool from the Software AG Event Replicator Administration Start
Programs submenu.

Or:

Locate and run the MappingTool.exe file in the installation directory.

The Data Mapping Tool starts up and it primary window appears.

Using the Data Mapping Tool12
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To start the Data Mapping Tool in UNIX environments, complete the following steps:

■ Run the MappingTool.sh file in the installation directory.

The Data Mapping Tool starts up and it primary window appears.

13Using the Data Mapping Tool
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Shutting Down the Data Mapping Tool

To shut down the Data Mapping Tool:

■ Click the Exit button on the Data Mapping Tool window.

The Data Mapping Tool shuts down.

The Data Mapping Tool Interface

This section describes the Data Mapping Tool window, menus, and buttons. It covers the following
topics:

■ Data Mapping Tool Main Window
■ Menus
■ Buttons
■ Icons

Data Mapping Tool Main Window

The Data Mapping Tool main window is divided into three columns.

Using the Data Mapping Tool14

Data Mapping Tool User Interface and Mechanics



The far left column,SYSTRANSDDMs, lists available DDMs. Once you have identified a directory
containing DDMs, the DDMs in that directory get listed in this column. For information on
identifying the directory containing your DDMs, read Locating and Selecting a Source DDM,
elsewhere in this guide.

The middle column, Target RDBMS, lists the target relational database tables to which you will
map fields from your DDM. To add and remove target relational databases from this list, read
Adding a Target Database, elsewhere in this guide.

The right column, GFB Schema, displays the GFB schema that is created when you drag a DDM
onto an RDBMS. A GFB and field table (GFFT) can be generated from this schema.

15Using the Data Mapping Tool
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Menus

The Data Mapping Tool main window includes five menus. The options available from these
menus are described in this section:

■ File Menu
■ GFB Menu
■ Options Menu
■ Targets Menu
■ Help Menu

File Menu

The File menu consists of the following menu options:

DescriptionMenu Option

Allows you to specify the directory in which data definition modules (DDMs)
can be found. For more information, read Locating and Selecting a Source
DDM, elsewhere in this guide.

Find SYSTRANS DDM
Directory...

Allows you to save the RDBMS target table and GFB schema listed on the
screen. The next time you start up the Data Mapping Tool, this table and
GFB schema will automatically appear.

Save Mapping

Allows you to shut down the Data Mapping Tool.Exit

GFB Menu

The options on the GFB menu only become available once a GFB schema appears in the GFB
Schema column of the screen. It consists of the following menu options:

DescriptionMenu Option

Allows you to redefine a field in the schema. For more information, readRedefining
Schema Fields, elsewhere in this guide.

Redefine

Allows you to specify that a field selected in the schema is the primary key or is
part of a composite key. For more information, read Specifying Keys, elsewhere in
this guide.

Set Primary Key

Allows you to specify that a field selected in the schema is no longer the primary
key or part of a composite key. For more information, read Specifying Keys,
elsewhere in this guide.

Remove Primary Key

Allows you to generate the GFB and field table, based on the selected GFB schema.
For more information, read Generating a GFB and Field Table, elsewhere in this
guide.

Generate GFB/GFFT

Using the Data Mapping Tool16
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Options Menu

The Options menu consists of the following menu options:

DescriptionMenu Option

Allows you to set the logging level for Data Mapping Tool processing. For more
information, read Managing Logging and Log Files, elsewhere in this guide.

Logging Level

Allows you to specify the default number of occurrences of repeating elements
for each MU or PE field if you want them to be flattened during replication. When

Default Occurrences..

you drag a DDM onto an RDBMS target to create a GFB schema, you are presented
with a panel on which you can override this default for each MU or PE field. For
more information, read Requesting MU and PE Field Flattening During
Replication, elsewhere in this guide

Allows you to specify the file extensions of the DDMs you want to see in the
leftmost column of the Data Mapping Tool main window.

DDM File Extensions..

Targets Menu

The Targets menu consists of the following menu options:

DescriptionMenu Option

Allows you to add and link to a target RDBMS. Once added, the RDBMS is listed
in the middle column of the Data Mapping Tool main window. For more
information, read Adding a Target Database, elsewhere in this guide.

Add RDBMS Target..

Help Menu

The Help menu consists of the following menu options:

DescriptionMenu Option

Allows you to access the online help for the Data Mapping
Tool

Help Contents

Lists version information about this installation of the Data
Mapping Tool.

About Event Replicator for Adabas - Data
Mapping Tool

17Using the Data Mapping Tool
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Buttons

The Data Mapping Tool main window includes the following buttons:

Note: Some of these buttons only become useable if specific items are selected in the Data
Mapping Tool screen.

DescriptionButton

Allows you to specify the directory in which data definition modules (DDMs) can be found.
For more information, read Locating and Selecting a Source DDM, elsewhere in this guide.

Saves the current mappings shown in the Data Mapping Tool. Target definitions in the target
list, GFB schemas, and source DDMs are saved.

Exits the Data Mapping Tool.

Allows you to redefine the selected GFB schema field. For more information, read Redefining
Schema Fields, elsewhere in this guide.

Allows you to specify that a field selected in the schema is the primary key or is part of a
composite key. For more information, read Specifying Keys, elsewhere in this guide.

Allows you to specify that a field selected in the schema is no longer the primary key or part
of a composite key. For more information, read Specifying Keys, elsewhere in this guide.

Allows you to generate the GFB and field table, based on the selected GFB schema. For more
information, read Generating a GFB and Field Table, elsewhere in this guide.

Exits the Data Mapping Tool.

Saves the current mappings shown in the Data Mapping Tool. Target definitions in the target
list, GFB schemas, and source DDMs are saved.

■ The Save button allows you to save the RDBMS target table and GFB schema listed on the screen.
The next time you start up the Data Mapping Tool, this table and GFB schema will automatically
appear.

■ The Exit button allows you to shut down the Data Mapping Tool.

Icons

The Data Mapping Tool main window uses the following icons:

DescriptionIcon

Identifies a DDM file in the leftmost pane.

Identifies a DDM in the leftmost pane, an RDBMS table in the center pane, and a GFB schema table
in the rightmost pane. In addition, this icon precedes the Show Tables and Refresh Tables options
on the right-click menu of an RDBMS or table in the center pane.

Using the Data Mapping Tool18
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DescriptionIcon

Identifies a simple field in the leftmost pane and an RDBMS column in the center pane. In addition,
this icon precedes the Show Columns and Refresh Columns List options on the right-click menu of
a table in the center pane.

Identifies a multiple value (MU) field in the leftmost pane.

Identifies a flattened multiple value (MU) field in the leftmost pane.

Identifies a periodic group (PE) field in the leftmost pane.

Identifies a flattened periodic group (PE) field in the leftmost pane.

Identifies a simple group field in the leftmost pane.

Identifies a subfield or superfield with occurrences in the leftmost pane.

Identifies a flattened subfield or superfield with occurrences in the leftmost pane.

Identifies a subfield or superfield with MU or PE occurrences in the leftmost pane.

Identifies a flattened subfield or superfield with MU or PE occurrences in the leftmost pane.

Identifies an RDBMS database in the center and rightmost panes. This icon also precedes the Add
RDBMS Target option on the Targets menu.

Identifies a GFB schema in the rightmost pane. In addition, this icon:

■ Precedes theGenerate GFB/GFFT option on the right-click menu of a GFB schema in the rightmost
pane.

■ Precedes the Generate GFB/GFFT option on the GFB menu.
■ Appears on a button on the main screen that allows you to generate the GFB and field table, based

on the selected GFB schema.

For more information, read Generating a GFB and Field Table, elsewhere in this guide.

Identifies a GFB schema field in the rightmost pane.

Identifies a GFB schema key field -- either the primary key or a field included in a composite key --
in the rightmost pane. In addition, this icon:

■ Precedes the Set PrimaryKey option on the right-click menu of a GFB schema field in the rightmost
pane.

■ Precedes the Set Primary Key option on the GFB menu.
■ Appears on a button on the main screen that allows you to identify a GFB schema field as a primary

key or composite key field.

For more information, read Specifying Keys, elsewhere in this guide.

Precedes the Set Composite Key Order option on the right-click menu of a GFB schema composite
key field in the rightmost pane.

19Using the Data Mapping Tool
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DescriptionIcon

Precedes the Remove Primary Key option on the right-click menu of a GFB schema key field in the
rightmost pane. This icon also:

■ Precedes the Remove Primary Key option on the GFB menu.
■ Appears on a button on the main screen that allows you to specify that a field selected in the schema

is no longer the primary key or part of a composite key.

Identifies a GFB schema foreign key in the rightmost pane.

Precedes the Flatten option on the right-click menu of a DDM field in the leftmost pane. For more
information, read Flattening Fields for Replication, elsewhere in this guide.

Precedes the Unflatten option on the right-click menu of a DDM field in the leftmost pane. For more
information, read Flattening Fields for Replication, elsewhere in this guide.

Precedes the Rename option on the right-click menu of a GFB schema or GFB schema field in the
rightmost pane.

Precedes the Redefine option on the right-click menu of a GFB schema field in the rightmost pane.
This icon also:

■ Precedes the Redefine option on the GFB menu.
■ Appears on a button on the main screen that allows you to redefine the selected GFB schema field.

For more information, read Redefining Schema Fields, elsewhere in this guide.

Identifies a child field of a redefined (split) field in the rightmost pane.

Appears on a button that allows you to save the current mappings shown in the Data Mapping Tool.
This icon also precedes the Save Mapping option on the File menu.

Appears on a button that allows you to specify the directory in which data definition modules (DDMs)
can be found. This icon also precedes the Find SYSTRANSDDMDirectory option on the Filemenu.

Precedes the Properties option on the right-click menu of a screen element.

Appears on a button that allows you to exit the Data Mapping Tool. This icon also precedes the Exit
option on the File menu.

Precedes the Delete option on the right-click menu of a screen element.

Precedes the Help Contents option on the Help menu. This option allows you to access the online
help for the Data Mapping Tool.

Using the Data Mapping Tool20
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6 Setting the Default Number of Occurrences for MU and PE

Fields

When you create a GFB schema, you can specify the number of multiple-value (MU) and periodic
group (PE) field occurrences for each MU or PE field in the DDM. However, you can also set a
default number of occurrences to be applied to the MU and PE fields prior to creating the GFB
schema. This chapter describes how to set this default. You can override this default if you decide
to flatten the MU and PE fields in the resulting RDBMS table or when you create the GFB schema
using the Data Mapping Tool.

To specify the default number of occurrences for MU and PE fields:

1 Select the Default Occurrences option on the Options menu.

The Set Default MU/PE Occurrences window appears.

2 In the Default MU/PE Occurrences field, specify the default number of repeating elements
for each MU or PE field that can be expected in the DDM.

3 When you have specified a default number of MU and PE field occurrences, select (check)
the Rescan DDMDirectory option. This option will cause the Data Mapping Tool to rescan
the DDM directory when you click OK, adjusting the MU and PE fields in the listed DDMs
to reflect this occurrence setting.
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4 When the default MU and PE field occurrences are specified and theRescanDDMDirectory
has been selected, click OK.

The Data Mapping Tool main window reappears and the default MU and PE field occurrence
setting is applied to all of the fields in the DDMs listed in the leftmost column.

Using the Data Mapping Tool22
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7 Locating and Selecting a Source DDM

To locate and select a source data definition module (DDM), complete the following steps:

Be sure you have generated and saved a DDM using Software AG's Natural or Predict products.

1 Once the Data Mapping Tool is started, select the Find SYSTRANSDDMDirectory... option
on the File menu.

Or:

Click on the button.

The Find SYSTRANS DDMDirectory browsing window appears.
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2 Using the Find SYSTRANSDDMDirectorywindow, locate the directory in which you have
stored your previously-generated DDMs. When you have located it click OK.

The leftmost SYSTRANS DDMs column of the Data Mapping Tool main window displays
the directory and may or may not specify any DDMs, depending on the file extensions of the
DDM files. If all of your DDMs are shown, you are finished. If only some or none of your
DDMs appear, you need to verify that the Data Mapping Tool has the correct list of DDM file
extensions assigned, as described in the rest of this procedure.

3 Select the DDM File Extensions option on the Options menu.

The Set DDM File Extensions window appears.

4 Verify that the Set DDM File Extensions window lists all of the file extensions of your
available DDMs. Separate the file extension specifications with an semicolon (;).

5 When all file extensions are listed, select (check) the Rescan DDMDirectory option. This
option will cause the Data Mapping Tool to rescan the DDM directory you specified when
you click OK, searching for DDMs with the file extensions you have specified.

6 When all file extensions are listed and the Rescan DDMDirectory has been selected, click
OK.

The Data Mapping Tool main window reappears and the DDM directory is rescanned for
DDMs with the extensions you requested. The leftmost column (SYSTRANSDDMs) lists all
the DDMs found.

7 Scroll through the DDM list and select a DDM in the list by clicking on it to highlight it.

Using the Data Mapping Tool24
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By default, when MU and PE fields and subfields and superfields are included in the replicated
data, additional tables are created, as described in . However, you can request that individual MU
fields, PE fields, subfields, and superfields be flattened in the replicated data instead. This process
of flatteningfields will replicate them as columns in the main table, rather than as separate subtables.

If you want to flatten a field in the resulting RDBMS table, you must trigger it in the DDM specific-
ation for the field. If you do not explicitly trigger a field to be flattened in DDM, it will not be
flattened in the resulting RDBMS tables.

Triggering Field Flattening

To trigger field flattening for a field, you must edit the field in your DDM. This section describes
this process.

To trigger field flattening for a field:

1 Expand the DDM in the SYSTRANSDDMs column of the Data Mapping Tool main window.

DDM files contain one or more DDMs. DDM files are prefixed with the icon ; DDMs are

prefixed with the icon .

2 Scroll through the fields in the DDM and locate the MU field, PE field, subfield, or superfield
for which you want to trigger flattening. MU fields are identified with the icon, PE fields
are identified with the icon, and subfields and superfields are identified with the icon.

3 Right-click on the field and select Flatten (Replicate to Columns) from the drop-down menu.

A Flatten dialog appears. For example, the following is a Flatten dialog for an MU field.
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The Occurrences area of the dialog contains two editable fields:

■ Flat Multiple Value (MU) Occurrences or Flat Periodic Group (PE) Occurrences
■ Flat Multiple Value (MU) Occurrences Start or Flat Periodic Group (PE) Occurrences
Start

4 Optionally, in the FlatMultiple Value (MU)Occurrences or Flat Periodic Group (PE) Occur-
rences field, specify the number of repeating elements for the field. Valid values must be
positive integers.

Note: A default number is suppled for this field. To specify what this default value
should be, read Specifying the Default Number of MU or PEOccurrences for Flattened
Fields, elsewhere in this section.

5 Optionally, in the Flat Multiple Value (MU) Occurrences Start or Flat Periodic Group (PE)
Occurrences Start field, specify the starting occurrence number. For example, if you want to
start with occurrence 15 rather than occurrence 1 (the default), you would specify "15" here.

6 Click OK when finished.

The fields will be marked for flattening when the GFB schema is created. In addition, the
DDM will expand with additional occurrences of the flattened fields as specified. You can
use this updated DDM then when creating and maintaining the GFB schema.
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Removing the Field Flattening Trigger

If, after you have specified that flattening should occur for a field, you decide not to flatten it, you
need to remove the flattening trigger defined for the field in the DDM. This section describes this
process.

To remove the field flattening trigger for a field:

1 Expand the DDM in the SYSTRANSDDMs column of the Data Mapping Tool main window.

2 Scroll through the fields in the DDM and locate the MU field, PE field, subfield, or superfield
for which you want to trigger flattening. Flattened MU fields are identified with the icon,
flattened PE fields are identified with the icon, and flattened subfields and superfields are
identified with the icon.

3 Right-click on the field and select Unflatten (Replicate to Sub-tables) from the drop-down
menu.

The DDM will remove the additional fields created by the flattening trigger. You can use this
updated DDM then when creating and maintaining the GFB schema.
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This chapter describes how to manage the list of target RDBMS databases in the Data Mapping
Tool.

Adding a Target Database

To add a target relational database (RDBMS):

1 Select the Add RDBMS Target.. menu option from the Targets menu .

The Add RDBMS Target window appears.

2 Fill in the fields on the Add RDBMS Target window as described in the following table:

Required?DescriptionField Name

YesSpecify the name of the target database. This name must match the
name of the RDBMS catalog.

Name

YesScroll through the list of RDBMS types and select any of the listed
database types.

Type

YesEdit the connection string that appears, based on the type of database
you have selected. .

Connection String
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Required?DescriptionField Name

NoSpecify the SQL prefix or schema for the target database, if necessary.
This specification is case-sensitive and is required for Oracle and DB2
databases.

SQL Prefix / Schema

YesSpecify a user ID authorized to access and update the RDBMS.User ID

YesSpecify the password of the user ID with authorization for the RDBMS.Password

3 When all fields have been supplied as required, click the OK button to save the connection
to the RDBMS.

The Data Mapping Tool main window reappears and the RDBMS is listed in the Target RD-
BMS column.

Removing a Target Database

To remove a target database from the list in the Target RDBMS column of the Data Mapping Tool main
window:

1 Right-click on the RDBMS in the Target RDBMS list that you want to remove.

2 Select the Delete menu option from drop-down menu.

The target database is removed from the list. The RDBMS itself is not removed; it is removed
only from the list in the Target RDBMS column. To remove the tables from the RDBMS, you
must do so using the management tools provided with the RDBMS.

Showing and Refreshing RDBMS Tables

You can optionally show the RDBMS tables and refresh the list of tables, as needed.

To show the tables in an RDBMS listed in the Target RDBMS column of the Data Mapping Tool main window:

1 Right-click on the RDBMS in the Target RDBMS list whose tables you want to show.

2 Select the Show Tables menu option from drop-down menu.

The list of tables in the RDBMS appears.
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To refresh the table list for an RDBMS listed in the Target RDBMS column of the Data Mapping Tool main
window:

1 Right-click on the RDBMS in the Target RDBMS list whose tables you want to refresh.

2 Select the Refresh Tables menu option from drop-down menu.

The list of tables for the RDBMS is refreshed.

Showing and Refreshing Columns

You can optionally show the columns in an RDBMS table and refresh the list of columns in a table,
as needed.

To show the columns in an RDBMS table listed in the Target RDBMS column of the Data Mapping Tool main
window:

1 Expand the RDBMS in the Target RDBMS column to see the tables included in it. If you
cannot expand the RDBMS, verify that you have requested that the tables be shown for that
RDBMS. Read Showing and Refreshing RDBMS Tables for more information.

2 Right-click on the RDBMS table in the Target RDBMS list whose columns you want to show.

3 Select the Show Columns menu option from drop-down menu.

The list of columns in the RDBMS table appears.

To refresh the column list for an RDBMS table listed in the Target RDBMS column of the Data Mapping Tool
main window:

1 Right-click on the RDBMS table in theTarget RDBMS list whose columns you want to refresh.

2 Select the Refresh Columns menu option from drop-down menu.

The list of columns for the RDBMS table is refreshed.
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Maintaining RDBMS Connection Properties

You can maintain the connection properties for any RDBMS listed in the Target RDBMS column
of the Data Mapping Tool main window.

To review connection properties for an RDBMS:

1 Right-click on the RDBMS in the Target RDBMS list whose properties you want to review
and maintain.

2 Select the Properties menu option from drop-down menu.

The properties are displayed in a Properties dialog.

3 Alter the fields on the Properties, if necessary, as described in Adding a Target Database,
earlier in this section.
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This chapter describes the creation and maintenance of GFB schema using the Data Mapping
Tool.

Note: If you want to use UTF-8 character encoding, you must verify that your GFB field
lengths are increased as required to accommodate the character set referenced by the code
page you select and the data requested in the GFB. You can increase these field lengths
manually by editing the Predict file or data definition module (DDM) used when the GFB
is generated.

Creating the Schema from an Entire DDM

You can create a GFB schema that maps all the fields in the DDM to tables in your RDBMS. One
table is created with the same name as the DDM and additional tables are created for each MU or
PE field within the DDM.

Once a GFB schema is created, you can use it to generate a global format buffer (GFB) and associated
field table (GFFT) for use by the Event Replicator for Adabas and the Event Replicator Target
Adapter. For more information, read Generating a GFB and Field Table, elsewhere in this guide.

To create the GFB schema from an entire DDM, complete the following steps:

1 Drag and drop a DDM from the SYSTRANSDDMs (leftmost) pane onto a target RDBMS in
the Target RDBMS (middle) pane. For complete information on listing DDMs in the SYS-
TRANS DDMs column and target relational databases in the Target RDBMS pane, read
Locating and Selecting a Source DDM andMaintaining the Target Relational Database List,
elsewhere in this guide.

Note: If you want to use UTF-8 character encoding, you must verify that your GFB field
lengths are increased as required to accommodate the character set referenced by the
code page you select and the data requested in the GFB. You can increase these field
lengths manually by editing the Predict file or data definition module (DDM) used
when the GFB is generated.

A Define GFB Schema Name dialog appears.
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2 Specify the name you want to use for the RDMS table on the Define GFB Schema Name
dialog. The name can be up to 32 characters long. The name you specify is used for the RDBMS
table and its subtables.

Note: This is not the same as the name of the global format buffer (GFB) definition used
by the Event Replicator for Adabas.

In addition, once you have selected a name here, you can always rename it in theGFBSchema
area of the Data Mapping Tool. For more information on renaming tables, the GFB Schema,
read Renaming Schema Tables, elsewhere in this guide.

3 Click OK.

TheSetMU/PEOccurrencesdialog appears, allowing you to specify the number of occurrences
for MU and PE fields for which no flattening has been triggered. The following is an example
of this dialog:

4 Optionally, adjust the MU or PE occurrence counts (MUOcc and PE Occ fields) and the MU
or PE starting occurrence number (MUOcc Start and PE Occ Start fields) for the unflattened
MU and PE fields listed in this dialog. Valid values must be positive integers.

5 Click OK when finished.

When all MU and PE fields have been accounted for, the GFB schema is created in the GFB
Schema (rightmost) pane of the Data Mapping Tool main window.

The GFB schema consists of one or more tables. One table is created for the DDM; an additional
table is created for each unflattened MU field, PE field, subfield, or superfield in the DDM.
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Creating the Schema from Individual Fields in the DDM

You can create a GFB schema that maps individual fields in a DDM to existing tables in your
RDBMS. You can also create a GFB schema that maps all the fields in a DDM to previously un-
defined tables in your RDBMS. For more information, read Creating the Schema from an Entire
DDM, elsewhere in this guide. Once a GFB schema is created, you can use it to generate a global
format buffer (GFB) and associated field table for use by the Event Replicator for Adabas and the
Event Replicator Target Adapter. For more information, read Generating a GFB and Field Table,
elsewhere in this guide.

Note: By default, if the table you are mapping to was not originally created by the Event
Replicator Target Adapter, it may not contain the field ISN. If this is the case, replication to
this target will likely fail with an error indicating that the RDBMS does not contain an ISN
column. Even if the ISN field is not defined as a primary key, its value in each Adabas record
is always replicated to the target base (parent) table. To resolve this problem, we recommend
that you alter the table in your target RDBMS, adding a column named "ISN" and defined
as type integer. Alternatively, you could set the Event Replicator Target Adapter Adabas-
RDBMSSynchronization Level field to "apply" in the target database option definition for
replication to your RDBMS. For more information about target database option definitions
in Event Replicator Target Adapter, read Specifying Target Database Processing Option Defin-
itions, in the Event Replicator Target Adapter Administrator's Guide.

To create the GFB schema from individual fields in the DDM, complete the following steps:

1 Be sure that you have expanded the tables and table columns in the Target RDBMS pane of
the Data Mapping Tool main window.

2 Drag and drop a single field from the DDM in the SYSTRANS DDMs (leftmost) pane onto
an existing field (table column) name in a table in the target RDBMS listed in the Target RD-
BMS (middle) pane.

The following general rules must be followed:

■ For MU (multiple occurrence), PE (periodic group), SB (subfield), or SP(superfield) fields,
the target table name must conform to the primary/foreign key naming relationships used
by the Event Replicator Target Adapter.

■ The length of the field being mapped must not exceed the length of the field (column) in
the RDBMS table.

■ Consideration should be given to matching data types of the fields in the DDM and the
fields in the target table. Do not attempt to map fields of different data types.

■ If you want to use UTF-8 character encoding, you must verify that your GFB field lengths
are increased as required to accommodate the character set referenced by the code page
you select and the data requested in the GFB. You can increase these field lengths manually
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by editing the GFB itself or by editing the Predict file or data definition module (DDM)
used when the GFB is generated.

■ Duplicate mappings in the same target table are not allowed. You cannot map the same
field to the same target RDBMS table and column combination.

■ If the ISN is not the primary key of your existing RDBMS table, you must change the primary
key assignment. Likewise, if your RDBMS table uses multiple primary keys, you must set
each composite key field and then specify the composite key order. For more information
on maintaining primary and composite keys in your GFB schema, read Specifying Keys,
elsewhere in this guide.

Note: In addition, if ISN is not the primary key, you must also manually add a dummy
ISN column into the target table with integer as its data type. This will ensure that
replication occurs successfully.

For complete information on listing DDMs in the SYSTRANS DDMs pane and target rela-
tional databases in the Target Table pane, read Locating and Selecting a Source DDM and
Linking to a Target Database, elsewhere in this guide.

The GFB schema is partially created in the rightmost (GFBSchema) pane of the Data Mapping
Tool main window.

3 Repeat step 1 until all fields are mapped.

The GFB schema is updated in the GFB Schema (rightmost) pane of the Data Mapping Tool
main window.

4 Optionally, rename the GFB schema in the GFB Schema pane. By default, schemas created
from individual fields in the DDM have the same name as the name of the RDBMS table to
which they are mapped. For complete information on renaming a GFB schema, readRenaming
Schemas, elsewhere in this guide.

5 Click Save when finished.

The GFB schema has been created in the GFB Schema (rightmost) pane of the Data Mapping
Tool main window. You can now use the Data Mapping Tool to generate a GFB and field
table from the GFB schema.
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Renaming Schemas

Once a GFB schema is created, you can rename it if necessary.

To rename a GFB schema once it is created:

1 Right-click on the name of the schema you want to rename in the GFB Schema column of the
main Data Mapping Tool window.

GFB schema names (which will result in the main table name of your RDBMS table) are shown

in the list prefixed by the icon .

A drop-down menu appears.

2 Select Rename from the drop-down menu.

A Rename GFB Schema dialog appears.

3 Specify a new name for the GFB schema in the dialog box and click OK.

The GFB schema is renamed.

Renaming Schema Fields

Once a GFB schema is created, you can rename any of the schema fields in the table if necessary.

To rename a GFB schema field in an GFB schema:

1 Right-click on the name of the schema field you want to rename in the GFB Schema column
of the main Data Mapping Tool window.
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GFB schema field names (which will result in the name of a column in your RDBMS table)
are shown in the list prefixed by the icon .

A drop-down menu appears.

2 Select Rename from the drop-down menu.

A Rename RDBMS ColumnMapping dialog appears.

3 Specify a new name for the GFB schema field (RDBMS table column) in the dialog box and
click OK.

The field is renamed.

Reviewing GFB Schema Field Properties

You can review the proprieties of a GFB schema field.

To review a GFB schema field's properties:

1 Right-click on the name of the schema field whose properties you want to review in the GFB
Schema column of the main Data Mapping Tool window.

GFB schema field names are shown in the list prefixed by the icon .

A drop-down menu appears.

2 Select Properties from the drop-down menu.

The Properties: GFB Schema Field: fieldname dialog appears, listing the GFB schema field
properties.
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Most of the fields in this dialog are read-only. If the field is an MU field, a PE field, a subfield,
or a superfield you can modify the settings in the Occurrences section of this dialog. The fol-
lowing example shows the Occurrences section of a field properties dialog for an MU field:
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3 If the field is an MU field, a PE field, a subfield, or a superfield, optionally modify the occur-
rence count or starting occurrence number in the Occurrences section of the dialog.

4 Click OK when you are done reviewing the properties.

Redefining Schema Fields

Once you have created a GFB schema, you can redefine a schema field. This is especially useful
if you want to split a field into multiple smaller fields (column) in the resulting RDBMS table. In
a Data Mapping Tool schema, you can redefine a field into multiple fields unless it is:

■ a key field (primary or composite key field)
■ a descriptor field (superdescriptor, subdescriptor, hyperdescriptor, phonetic, or collation

descriptor)

Note: Installations wishing to redefine schema fields must have Event Replicator for Adabas
3.2.1 or later installed.

Multiple value fields (MU fields) and periodic groups (PE fields) are supported.

In addition, you can redefine fields into combinations of the following data types: alphanumeric,
binary, date, floating point, integer, logical, numeric, packed decimal, and time.

Finally, a field that is redefined cannot be expanded beyond its original field length unless it is
first expanded in the original record and associated DDM. Once a GFB schema is created, you
cannot increase the overall size of a field; so the sum of the sizes of the child fields that comprise
a redefined field (the parent) must be less than or equal to the size of the original parent field.
Note that you can also leave spaces between child fields of a redefined field; the Data Mapping
Tool detects these spaces and fills them with read-only filler fields when you generate the GFB
and associated field table (GFFT) entries. Filler fields appear in the GFFT with column names of
FILLER.

Note: Fields that have been redefined cannot become primary keys and cannot be included
in composite keys for the table.
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To redefine a schema field:

1 Right-click on the name of the schema field whose properties you want to redefine in theGFB
Schema column of the main Data Mapping Tool window.

GFB schema field names are shown in the list prefixed by the icon .

A drop-down menu appears.

2 Select Redefine from the drop-down menu.

TheRedefineGFBSchema Field:fieldname dialog appears, listing the GFB schema field you
can split and its child entries (if any have been defined yet). In the following sample, the
parent field has not yet been split, so when this dialog appears, it shows only a single child
field, which has the exact length and specifications of the parent field.

You can tab or click in the cells of this table of child fields, as needed, to alter the child field
settings.

3 In the table, change the length of the first child field in the associated Adabas Length field,
to accommodate additional child fields. If you do not do this, you can only specify a single
child field (since the lengths of the child fields cannot exceed the length of the parent field).
In addition, you must specify the column name for the child field in the RDBMS Column
Name field.

Optionally, adjust the format (Adabas Format field) and offset (Offset field) of the child field
in the table.

4 Maintain additional child fields, as necessary, in the table of child fields.
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For every child field you define, you must specify a length and an RDBMS column name. If
you do not specify an offset for a child field, the Data Mapping Tool automatically calculates
it based on the lengths of the other child fields. If you do not specify a field format for a child
field, the format of the parent field is assumed.

■ To add a child field, click the Add button. A new blank child line becomes editable in the
table.

■ To insert a new child field between two fields already in the table, select the Action box
(check it) of the lower child field and then click the Insert button. A new blank child line
is inserted between the two existing child fields and becomes editable in the table.

■ To delete a child field from the table, select the Action box (check it) of the child field and
then click the Delete button. The child field is removed from the table.

5 When all child fields have been specified in the table, click Done.

The field appears as redefined (split) in the GFB schema. When the GFB and associated field
table are generated, the redefined field will appear as multiple columns in the resulting RDBMS
table.

To undo a schema field redefinition:

1 Right-click on the name of the schema field whose redefined properties you want to undo in
the GFB Schema column of the main Data Mapping Tool window.

GFB schema field names are shown in the list prefixed by the icon .

A drop-down menu appears.

2 Select Redefine from the drop-down menu.

TheRedefineGFBSchema Field:fieldname dialog appears, listing the GFB schema field you
can redefine and its child entries. In the following sample, the parent field, PERSONNEL-ID,
has been split into three child fields: Division Code, Branch Code, and Sequence Number.
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3 For each child field, select theAction box (check it) and then click theDelete button. The child
field is removed from the table.

4 Click Done.

The child fields are removed from the GFB schema and the parent field is no longer redefined
(split). When the GFB and associated field table are generated, the parent field will appear as
a single column in the resulting RDBMS table.

Specifying Keys

By default, the ISN (internal sequence number) is the primary key of every record in the GFB
schema. However, the Data Mapping Tool allows you to change the primary key of the table in
the schema and it allows you to select multiple keys to be used as a composite key for the table.

Key fields in the schema are prefixed by the icon .

Notes:

1. Split (redefined) columns cannot become primary keys and cannot be included in composite
keys.

2. The Event Replicator Target Adapter will not process updates for a field that is the primary
key for an RDBMS table or for any fields that comprise a composite key for the table.

3. At this time, the Event Replicator Target Adapter does not support the use of MU or PE fields
as primary keys or in composite keys.
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This section covers the following topics:

■ Changing the Primary Key
■ Creating a Composite Key
■ Changing the Composite Key Order
■ Removing Primary Key Specification

Changing the Primary Key

To change the primary key:

1 Right-click on the name of the schema field that you want to make a primary key in the GFB
Schema column of the main Data Mapping Tool window.

GFB schema field names are shown in the list prefixed by the icon .

A drop-down menu appears.

2 Select Set Primary Key from the drop-down menu.

The schema field you selected becomes the primary key for the table. If the ISN field was the
primary key prior to this change, it is no longer listed in the schema.

Creating a Composite Key

A composite key is key that is comprised of multiple fields in the schema. Any field except the
ISN field and redefined (split) fields can be used in a composite key.

Note: Installations wishing to create composite keys must have Event Replicator for Adabas
3.2.1 or later installed.

To create a composite key:

1 Right-click on the name of a schema field that you want to make part of a composite key in
the GFB Schema column of the main Data Mapping Tool window.

Note: At this time, the Event Replicator Target Adapter does not support the use of
MU or PE fields as primary keys or in composite keys.

GFB schema field names are shown in the list prefixed by the icon .

A drop-down menu appears.

2 Select Set Primary Key from the drop-down menu.

47Using the Data Mapping Tool

Creating and Maintaining the GFB Schema



The schema field you selected becomes a key for the table. If the ISN field was the primary
key prior to this change, it is no longer listed in the schema. The ISN field cannot be used in
a composite key.

3 Repeat steps 1 and 2 for any additional fields you want to included in the composite key.

All fields you have identified as key fields are combined to create a composite key and are

prefixed by the icon in the schema.

Read Changing the Composite Key Order, next in this section, for information on how to
specify the order of the fields in the composite key.

Changing the Composite Key Order

By default, the order of the fields in a composite key is the same as the order of the original primary
key selection.

To change the order of the fields in a composite key:

1 Right-click on the name of any of the schema fields that comprise the composite key in the
GFB Schema column of the main Data Mapping Tool window.

Key field names are shown in the list prefixed by the icon .

A drop-down menu appears.

2 Select Set Composite Key Order from the drop-down menu.

The Set Composite Key Order dialog appears.

3 You can reorder the fields in the composite key using the Set Composite Key Order dialog.
Simply select the field you want to move (click on it) and click the Move Up or Move Down
buttons until it is placed where you want it.

4 When all composite key fields are in the order you want, click Done.

The dialog closes and the composite key order is logically updated. Any subtables containing
foreign and primary key references are updated to show the new composite key order.
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Removing Primary Key Specification

To remove the primary key specification for a field in the table:

1 Right-click on the name of the schema field that you want to remove as the primary key or
remove from a composite key in the GFB Schema column of the main Data Mapping Tool
window.

Key field names are shown in the list prefixed by the icon .

A drop-down menu appears.

2 Select Remove Primary Key from the drop-down menu.

The schema field you selected is no longer a primary key for the table. If no other primary
key is defined for a table, the ISN field appears as the primary key.

Reviewing GFB Schema Properties

You can review the proprieties of a GFB schema.

To review a GFB schema's properties:

1 Right-click on the name of the schema whose properties you want to review in the GFB
Schema column of the main Data Mapping Tool window.

GFB schema names are shown in the list prefixed by the icon .

A drop-down menu appears.

2 Select Properties from the drop-down menu.

The Properties: GFB Schema: schemaname dialog appears, listing the GFB schema properties.

You cannot edit any properties on this dialog.

3 Click OK when you are done reviewing the properties.
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Removing a GFB Schema

You can remove a GFB schema from the Data Mapping Tool (for example, if you want to start
over).

To rename a GFB schema once it is generated:

1 Right-click on the name of the schema you want to remove from the GFB Schema column of
the main Data Mapping Tool window.

GFB schema names are shown in the list prefixed by the icon .

A drop-down menu appears.

2 Select Delete from the drop-down menu.

The GFB schema is removed.
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11 Generating a GFB and Field Table

Once you have created a GFB schema , you can generate a GFB and field table (GFFT). The generated
GFB and field table file can be imported into Event Replicator Administration for use with the
Event Replicator Target Adapter. For information on importing the file, read Importing a Data
Mapping Tool GFB and Field Table in Event Replicator Administration User's Guide.

For information on using the Event Replicator Target Adapter, read Submitting Event Replicator
Target Adapter Requests (in the Event Replicator Administration User's Guide) and the Overview in
Event Replicator Target Adapter User Guide.

To generate a GFB and field table, complete the following steps:

1 Create a GFB schema as described in Creating and Maintaining the GFB Schema, elsewhere
in this guide.

2
If desired, save the GFB schema by clicking on the button or the button on the
Data Mapping Tool main window or by clicking on the Save Mapping option on the File
menu.

3 Right-click on the name of the GFB schema in the GFB Schema column of the Data Mapping
Tool main window.

The GFB schema name is prefixed by the icon .

A drop-down menu appears.

4 Click on the Generate GFB/GFFT option on the drop-down menu.

Or:

You can also select the Generate GFB/GFFT option on the GFB menu.

The GFB and field table are generated and the Generate GFB/GFFT dialog appears.
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You can use this dialog to review the generated GFB and GFFT.

5 Click the Save button to save the generated GFB and its associated field table (GFFT).

A save dialog appears allowing you to specify a directory and file name for the generated
file.

6 Use the save dialog to save the GFB/GFFT file.

Once you have saved the generated GFB and field table file, you can import it into Event
Replicator Administration for use with the Event Replicator Target Adapter. For information
on importing the file, read Importing a DataMapping Tool GFB and Field Table in Event Replicator
Administration User's Guide.
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12 Managing Logging and Log Files

■ Log File Location ............................................................................................................................. 54
■ Reviewing the Log Files .................................................................................................................... 54
■ Setting Log Levels ........................................................................................................................... 54
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When the Data Mapping Tool is installed, all Data Mapping Tool messages are automatically
written to the Data Mapping Tool log file. You can control the level of log messages written to the
Windows and UNIX event logs; read Setting Log Levels, elsewhere in this chapter, for more in-
formation.

Log File Location

All Data Mapping Tool log files are stored in the MappingTool\logs subdirectory of your Data
Mapping Tool installation. The Data Mapping Tool log file name is MT-log.txt.nn, where nn is a
sequential number of the log file (newest log files have the lowest or no number). The log files
contain all current log messages, including statistics about the Data Mapping Tool session pro-
cessing. If you have a problem, please keep this log file.

Reviewing the Log Files

The log files can be reviewed using a text editor.

Setting Log Levels

You can set the log level of messages written to the log files. Seven log levels are available (listed
in order of settings that result in the most logging to those resulting in the least logging):

DescriptionLog Level

All messages are logged or displayed.

Note: Setting this log level can impact performance.

TRACE

Only debugging, informational, warning, error, and fatal messages are logged or displayed.

Note: Setting this log level can impact performance.

DEBUG

Only informational, warning, error, and fatal messages are logged or displayed.INFO

Only warning, error, and fatal messages are logged or displayed.WARN

Only error and fatal messages are logged or displayed.ERROR

Only fatal messages are logged or displayed.FATAL

No logging occurs or displayed.OFF
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To change the log level of messages written to the log files:

1 Once the Data Mapping Tool is started, select the Logging Level... option on the Options
menu.

Or:

Click on the button.

The Set Logging Level dialog appears.

2 Select the log level as needed. Valid log level values are TRACE, DEBUG, INFO, WARN,
ERROR, FATAL, and OFF, as described earlier in this section.

Note: Setting the log level to TRACE or DEBUG can impact performance.

3 When the trace level has been selected, click OK.
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